
CHAPTER 1

Getting to Know
AutoCAD
� Opening a new drawing

� Getting familiar with the AutoCAD and AutoCAD LT
Graphics windows

� Modifying the display

� Displaying and arranging toolbars
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Y
our introduction to AutoCAD and AutoCAD LT begins with a tour of the
features of the screens used by the two programs. In this chapter, you’ll
also learn how to use some tools that help you control the screen’s appear-
ance and how to find and start commands. For the material covered in

this chapter, the two applications are almost identical in appearance. Therefore,
as we tour AutoCAD, I’ll point out any differences between AutoCAD and Auto-
CAD LT. In general, LT is a 2D program, so it doesn’t have most of the 3D features
that come with AutoCAD, such as solids modeling and rendering. The other dif-
ferences are minor. As mentioned in this book’s introduction, when I say Auto-
CAD, I mean both AutoCAD and AutoCAD LT. I’ll also refer to AutoCAD LT as LT
throughout this chapter and the rest of the book. Starting up AutoCAD is the first
task at hand. 

Starting Up AutoCAD
If you installed AutoCAD or LT using the default settings for the location of the
program files, start AutoCAD by choosing Start ➣ All Programs ➣ Autodesk ➣

AutoCAD 2007 ➣ AutoCAD 2007. For LT, choose Start ➣ All Programs ➣ Auto-
desk ➣ AutoCAD LT 2007 ➣ AutoCAD LT 2007. If you customized your installa-
tion, find and click the AutoCAD 2007 or the AutoCAD LT 2007 icon to start the
program.

As AutoCAD comes up, you may see a welcoming screen that offers two default
workspaces to choose from: 3D Modeling and AutoCAD Classic (see Figure 1.1a).
If you see this screen, select AutoCAD Classic and click OK. The program may
then display the Startup Dialog box. LT may display a similar welcoming screen
that offers only one workspace—AutoCAD LT. Click OK to continue.

The Startup Dialog Box
If AutoCAD or LT opens with the Startup dialog box sitting in front of the Auto-
CAD Graphics window, your screen will be similar to Figure 1.1b. If you don’t see
the Startup dialog box, read on a little—you’ll see how to display it and then how
to suppress it.

The Startup dialog box has four buttons in the upper-left corner. The first two
buttons let you set up a new drawing and choose an existing drawing to revise or
update. The second two buttons use templates and wizards to initiate advanced
setup routines. The contents of the middle portion of the dialog box depend on
which of the four buttons you choose. By beginning a new drawing, you can get
past this dialog box to the AutoCAD Graphics window:

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D2

�

Dialog boxes with
various combinations
of buttons and text
boxes are used exten-
sively in AutoCAD
and LT.You’ll learn
their many functions
as you progress
through the book.
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F I G U R E 1 . 1 :  The Workspaces welcoming screen (a), and the Startup dialog
box (b)

1. Click the Start From Scratch button, the second button from the left.

2. In the Default Settings section, click the Imperial (Feet And Inches)
radio button.

3. Click OK to close the Startup dialog box. Your monitor displays the
AutoCAD or LT Graphics window, sometimes called the Graphical User
Interface, or GUI (see Figures 1.2a and b). In LT, your screen looks
similar to Figure 1.2a. For AutoCAD, your monitor displays either of
two workspaces: the AutoCAD Classic workspace (see Figure 1.2a) or
the 3D Modeling workspace (see Figure 1.2b). You’ll be using a varia-
tion of the AutoCAD Classic workspace for all 14 chapters in this book.
In the appendix, you’ll switch to the 3D Modeling workspace, but for
now, you need to get your AutoCAD GUI to look like Figure 1.2a. 

S t a r t i n g  U p  A u t o C A D 3
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Radio buttons are
round and come in a
list or a group. You
can activate only
one radio button at
a time.

a

b
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F I G U R E 1 . 2 : The AutoCAD Graphics window using two workspaces: AutoCAD Classic (a),
and 3D Modeling (b)

Title bar Menu bar Drawing area Standard toolbar Properties toolbarLayers toolbar

Crosshair cursor

Draw toolbar

Modify toolbar

Model and Layout tabsUser Coordinate
System icon

Status barCommand window

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D4

a

b

08776ch01.qxd  3/29/06  1:33 AM  Page 4



N O T E If the New Features Workshop window appears when you start
up AutoCAD, click the second or third radio button in the window, and then
click OK to remove it. You can always access the Workshop on the Help menu.

If your screen already looks similar to Figure 1.2a, go on to the sidebar “Con-
trolling the Way AutoCAD Starts Up.” The toolbars on your screen may not be in
exactly the same places as they are shown here. Later in this chapter, you’ll see
how to move the toolbars, display new ones and place them, and suppress them.
If your screen looks like Figure 1.2b or isn’t at all like Figure 1.2a, you need to
make a few changes:

1. Click Tools ➣ Workspaces ➣ AutoCAD Classic. (If AutoCAD Classic
already has a check in the box next to it, or if you are using LT, this
step is unnecessary.)

2. By default, the AutoCAD Classic workspace displays two palettes on
the screen. If the palettes are displayed, you need to turn them off for
now. Click Tools ➣ Palettes ➣ Tool Palettes to turn off the one on the
right, and then click Tools ➣ Palettes ➣ Sheet Set Manager to turn
off the one on the left. Your workspace may have different toolbars
and palettes displayed than those shown here. If other palettes are
still visible, click the X in the upper-right or -left corner of each
palette to close it.

3. The large area in the middle of the screen is called the drawing area.
It may need adjusting. Click View ➣ Visual Styles ➣ 2D Wireframe. 

4. Click View ➣ 3D Views ➣ Plan View ➣ World UCS. If dots appear in
the drawing area, the grid is on.

5. Move the cursor to the status bar at the bottom of the screen, and
click the Grid readout button so it’s in the off (unpushed) mode. 
Be sure all the other readout buttons except Model are in their off
position.

Your screen should look close enough to Figure 1.2a to continue. You’ll
arrange the toolbars to the way you need them a little later.

S t a r t i n g  U p  A u t o C A D 5

�

LT Users can skip
Steps 3 and move on
to Step 4.

08776ch01.qxd  3/29/06  1:33 AM  Page 5



CONTROLL ING THE WAY AUTOCAD STARTS UP

You can set AutoCAD and LT to display or hide the Startup dialog box when
you start AutoCAD:

1. From the menu bar, choose Tools ➣ Options to open the Options dia-
log box.

2. Click the System tab to bring it forward.

3. In the General Options section, open the Startup drop-down list:

� If you want AutoCAD to display the Startup dialog box, click Show
Startup Dialog Box.

� If you want AutoCAD to start up with a blank drawing, click Do
Not Show A Startup Dialog.

4. Click Apply, and then click OK.

The next time you start up AutoCAD, your preference will be used.

Introduction to the AutoCAD 
Graphics Window
At the top of the Graphics window sit the title bar, the menu bar, and three tool-
bars. You may have more or less than three toolbars; if so, you’ll change that soon. 

The title bar is analogous to the title bar in any Windows program. It contains
the program name (AutoCAD or AutoCAD LT) and the title of the current draw-
ing with its path. Below the title bar is the menu bar, where you’ll see the drop-
down menus. Among the drop-down menus, File, Edit, Window, and Help are
Windows menus (meaning that they appear on most Windows applications).
These Windows menus also contain a few commands specific to AutoCAD. The
rest of the menus are AutoCAD menus.

Below these menus is the Standard toolbar, which contains 25 command but-
tons (LT has only 23). Several of these buttons will be familiar to Windows users;

Title bar Menu bar Standard toolbar

Properties toolbarLayers toolbar 

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D6

�

The title bar and
menu bar at the top
of the LT screen are
identical to those in
AutoCAD except that
AutoCAD LT appears
in the title bar rather
than AutoCAD.
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the rest are AutoCAD commands. Just below the Standard toolbar are the Layers
toolbar and the Properties toolbar, which together contain three command but-
tons and five drop-down lists. If you selected the AutoCAD Classic workspace,
you’ll have a Workspaces toolbar to the left of the Layers toolbar. 

The blank middle section of the screen is called the drawing area. Notice the
movable crosshair cursor. The crosshairs on your cursor may not extend com-
pletely across the screen. I recommend that you set them to look like they do in
the figures in this book, and I will show you how to do this when we make a few
changes later in this chapter. Your screen may or may not display the coordinate
tool tips next to the intersection of the crosshairs.

Notice the little box at the intersection of the two crosshair lines. This is one
of several forms of the AutoCAD and LT cursor. When you move the cursor off
the drawing area, it changes to the standard Windows pointing arrow. As you
begin using commands, it will take on other forms, depending on which step of a
command you’re in.

The icon with a double arrow in the lower-left corner of the drawing area is the
User Coordinate System icon. It indicates the positive direction for the X and Y
coordinates. You won’t need it for most of the chapters in this book, so you’ll
learn how to make it invisible in Chapter 3.

At the bottom of the drawing area are three tabs: a Model tab and two Layout
tabs. You use these tabs to switch between viewing modes. (I’ll discuss viewing
modes in Chapter 13.) Our example shows no toolbars floating in the drawing
area, but two toolbars are docked at the left of the drawing area. Your screen may
or may not have the toolbars, or they may be in a different position. If the toolbars
are within the drawing area, they will have a colored title bar. For specifics, see the
section “The Toolbars” later in this chapter.

Coordinate tooltips

Drawing area

Crosshair cursor

User Coordinate
System icon Model and Layout tabs

I n t r o d u c t i o n  t o  t h e  A u t o C A D  G r a p h i c s  Wi n d o w 7
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Below the drawing area is the Command window.

The Command window is where you tell the program what to do and where the
program tells you what’s going on. It’s an important area, and you’ll need to learn
how it works in detail. Three lines of text should be visible. If your screen displays
fewer than three lines, you’ll need to make another line or two visible. You’ll learn
how to do this later in this chapter in the section “The Command Window.”

Below the Command window is the status bar.

On the left end of the status bar, you’ll see a coordinate readout window. In
the middle are 10 readout buttons (LT has only 9) that indicate various drawing
modes. It’s important to learn about the coordinate system and most of these
drawing aids (Snap, Grid, Ortho, and Osnap) early as you learn to draw in Auto-
CAD or LT. They will help you create neat and accurate drawings. Polar and
Otrack are advanced drawing tools and will be introduced in Chapter 5. Ducs
stands for Dynamic User Coordinate System; it’s used in 3D drawings. Dyn is an
OFF/ON toggle that activates or suppresses the dynamic display of information
next to the crosshair cursor when it’s in the drawing area. For now, keep it in the
OFF (unpushed) mode. Lwt (which stands for Lineweight) will be discussed in
Chapter 14 in the section on plotting. The Model button is an advanced aid that
will be covered in Chapter 13. At the far right of the status bar are small icons
that indicate the presence of various features for a drawing session. The Satellite
Dish button activates AutoCAD’s Communication Center and is discussed in a
bonus chapter available on Sybex’s website (www.sybex.com). The Padlock icon
controls which types of toolbars and windows are locked in their current posi-
tions on the screen. Leave it in the unlocked mode for now.

This has been a quick introduction to the various parts of the Graphics win-
dow. I didn’t mention a couple of items that may be visible on your screen. You
may have scroll bars below and to the right of the drawing area, and you may
have a menu on the right side of the drawing area. Both features can be useful,
but they can also be a hindrance and take up precious space in the drawing area.
They won’t be of any use while working your way through this book, so I suggest
that you remove them for now.

To temporarily remove these features, follow these steps:

1. Choose Tools ➣ Options to open the Options dialog box (shown in
Figure 1.3). It has 10 tabs (LT has only 8) across the top that act like
tabs on file folders.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D8

�

The Command win-
dow in LT is identi-
cal to the one in
AutoCAD.

�

LT doesn’t display
the Otrack or the
Ducs buttons on the
status bar.
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F I G U R E 1 . 3 :  The Options dialog box

2. Click the Display tab, which is shown in Figure 1.4. Focus on the rec-
tangular area titled Window Elements. If scroll bars are visible on the
lower and right edges of the drawing area, the Display Scroll Bars In
Drawing Window check box will be checked.

F I G U R E 1 . 4 :  The Options dialog box open at the Display tab

I n t r o d u c t i o n  t o  t h e  A u t o C A D  G r a p h i c s  Wi n d o w 9
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3. Click the check box to turn off the scroll bars. Also be sure the check box
for Display Screen Menu is unchecked. Don’t click the OK button yet.

Another display setting that you may want to change at this point controls the
color of the cursor and the drawing area background. The illustrations in this
book show a white background and black crosshair cursor, but you may prefer to
reverse the colors. To do so, follow these steps:

1. In the Window Elements area of the Display tab, click the Colors but-
ton to open the Drawing Window Colors dialog box (see Figure 1.5).
In the upper left corner of the dialog box, in the Context list box, 2D
Model Space should be visible. If it’s not, select it.

F I G U R E 1 . 5 :  The Drawing Window Colors dialog box

2. Move to the Color drop-down list, which is in the upper-right corner.
If your drawing area background is currently white, a square followed
by the word White is displayed. Open the Color drop-down list, and
select Black (or the background color you want). The drawing area
will now be that color, and the cursor color will change to white, as
shown in the Model Tab Preview window below.

3. Click the Apply & Close button to close the Color Options dialog box.

4. Don’t close the Options dialog box yet.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D1 0

�

LT doesn’t have the
Screen menu, so 
the option to turn it
off isn’t on LT’s
Display tab.
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5. If you want the lines of your crosshair cursor to extend completely
across the screen, go to the lower-left corner of the Display tab
(lower-right for LT) and move the slider to change the Crosshair
Size setting to 100. 

6. Click OK to close the Options dialog box.

Your screen and crosshair cursor take on their newly assigned colors, and the
crosshair lines extend across the drawing area.

T I P If you choose a color other than black as the drawing area back-
ground color, the color of the crosshair cursor remains the same as it was
(black). To change the crosshair color, in the Drawing Window Colors dialog
box, go to the Interface Element list box, and select Crosshairs. Then, select a
color from the Color drop-down list.

The Command Window
Just below the drawing area is the Command window. This window is separate
from the drawing area and behaves like a Windows window—that is, you can drag
it to a different place on the screen and resize it, although I don’t recommend that
you do this at first. If you currently have fewer than three lines of text in the win-
dow, you’ll need to increase the window’s vertical size. To do so, move the cursor to
the horizontal boundary between the drawing area and the Command window
until it changes to an up-and-down arrow broken by two parallel horizontal lines.

Hold down the left mouse button, drag the cursor up by approximately the
amount that one or two lines of text would take up, and then release the mouse.
You should see more lines of text, but you may have to try this a couple of times
to display exactly three lines. The top two lines of text will be separated by a line
from the bottom line of text. When you close the program, the new settings will
be saved; the next time you start up AutoCAD, the Command window will display
three lines of text.

The Command window is where you give information to AutoCAD and where
AutoCAD prompts you for the next step in executing a command. It’s a good prac-
tice to get into the habit of keeping an eye on the Command window as you work
on your drawing. Most errors occur when you aren’t looking at it frequently. If the
Dyn button on the status bar is activated, some of the information in the Command
window is displayed in the drawing area next to the cursor. We’ll look at this feature
when we start drawing.

T h e  C o m m a n d  Wi n d o w 1 1
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Before you begin to draw, take a close look at the menus, toolbars, and key-
board controls.

N O T E In many cases, you can start AutoCAD commands in a number of
ways: from drop-down menus, from the toolbars, from the keyboard, and from
menus that appear when you right-click the mouse. When you get used to
drawing with AutoCAD, you’ll learn some shortcuts that start commands
quickly, and you’ll find the way that is most comfortable for you.

Drop-Down Menus
The menu bar, just below the title bar (see Figure 1.2 earlier in this chapter),
consists of 11 (12 if you have the Express tools installed) words and an icon.
Click any of these to display a drop-down menu. The icon on the left end and
the File and Edit menus are included with all Windows-compatible applications,
although they are somewhat customized to work with AutoCAD. The menu
associated with the icon contains commands to control the appearance and
position of the drawing area.

Commands in the File menu are for opening and saving new and existing
drawing files, printing, linking on the Internet, exporting files to another appli-
cation, choosing basic utility options, and exiting the application. The Edit menu
contains the Undo and Redo commands, the Cut and Paste tools, and options for
creating links between AutoCAD files and other files. The Help menu works like
all Windows Help menus and contains a couple of AutoCAD-specific entries as
well, including some online resources and a context-sensitive help feature called
the Info Palette.

The other eight or nine menus contain the most-often-used AutoCAD com-
mands. You’ll find that if you master the logic of how the commands are orga-
nized by menu, you can quickly find the command you want. Here is a short
description of each of the other AutoCAD drop-down menus:

View Contains tools for controlling the display of your drawing file.

Insert Contains commands for placing drawings and images or parts of them
inside other drawings.

Format Contains commands for setting up the general parameters for a new
drawing.

Tools Contains special tools for use while you’re working on the current draw-
ing, such as those for finding the length of a line or for running a special macro.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D1 2
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Draw Contains commands for creating new objects (such as lines or circles) on
the screen.

Dimension Contains commands for dimensioning a drawing.

Modify Contains commands for changing existing objects in the drawing.

Window Contains commands for displaying currently open windows and lists
currently open drawing files.

Express An optional menu containing a library of productivity tools that
cover a wide range of AutoCAD functions. It may or may not be installed on
your computer.

The Toolbars
Look at the toolbars on your screen. You’ll have two to five toolbars in one or two
rows at the top, and a couple more on the right and/or left sides of the drawing
area. Just below the drop-down menus is the most extensive of the toolbars—the
Standard toolbar.

The icons on the AutoCAD toolbars don’t appear as buttons until you point to
them. There are 25 icons on the Standard toolbar, and they are arranged into
seven logical groups. The icons on the left half of the Standard toolbar are
mostly for commands used in all Windows-compatible applications, so you may
be familiar with them. The icons on the right half of the Standard toolbar are
AutoCAD commands that you use during your regular drawing activities for a
variety of tasks. You use these commands to take care of a number of tasks,
including the following:

� Changing the view of the drawing on the screen

� Changing the properties of an object, such as color or linetype

� Borrowing parts of an unopened drawing to use in your current
drawing

� Displaying a set of palettes that contain objects you can use in your
drawing

T h e  To o l b a r s 1 3

�

LT has only 23
Standard toolbar
buttons. It’s missing
the Sheet Set
Manager and Block
Editor buttons
because LT doesn’t
have these features.
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Toolbar Flyouts
Notice that one icon on the Standard toolbar has a little triangular arrow in the
lower-right corner. This arrow indicates that clicking this icon displays more
than one command. Follow these steps to see how this special icon works:

1. Move the cursor up to the Standard toolbar, and point to the icon
that has a magnifying glass with a rectangle in it.

2. Rest the arrow on the button for a moment without clicking. A small
window opens just below it, displaying the command the button rep-
resents. In this case, the window should say “Zoom Window.” This is
a tool tip—all buttons have them. Notice the small arrow in the
lower-right corner of the icon. This is the multiple-command arrow
mentioned earlier.

3. Place the arrow cursor on the button, and hold down the left mouse
button. A column of nine buttons drops down vertically below the
original button. The top button in the column is a duplicate of the
button you clicked. This column of buttons is called a toolbar flyout.
In this example, you’re working with the Zoom toolbar flyout.

4. While still holding down the mouse button, drag the arrow down
over each button until you get to the one that has a magnifying glass
with a piece of white paper on it. Hold the arrow there until you see
the tool tip. It should say “Zoom All.” Now release the mouse button.
The flyout disappears, and AutoCAD executes the Zoom All com-
mand. Look in the Command window at the bottom of the screen.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D1 4
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The Zoom All com-
mand changes the
view of your drawing
to include special pre-
set parameters. We’ll
look at this command
in Chapter 3.
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At the end of the top line of text is _all. This tells you that you have
used the All option of the Zoom command. This flyout is called the
Zoom flyout because it contains tools for changing views of the draw-
ing, or “zooming around in the drawing.”

5. Look at the Standard toolbar where the Zoom Window button was
previously. Notice that it’s been replaced by the Zoom All button.

T I P On a toolbar flyout, the button you select replaces the button that
was on the toolbar. This arrangement is handy if you’re going to be using the
same command several times, because the button for the command is readily
available and you don’t have to open the flyout to select it again. The order of
the flyout buttons remains the same, so when you open the Zoom flyout
again, the Zoom Window button will be at the top of the list. You’ll need to
become familiar with any flyout buttons you use, because the last one used
becomes the representative button on the home toolbar.

The behavior of the Zoom flyout on the Standard toolbar is the same as the
behavior of flyouts in general.

N O T E Whenever you start up AutoCAD or LT for a new drawing session,
the toolbars are reset and contain the original flyout buttons.

The toolbar flyouts are regular toolbars that have been attached to another
toolbar. There are 35 toolbars in all, and only 2 are flyouts—the Zoom flyout I
just discussed, and the Insert flyout on the Draw toolbar. You can display the
Zoom and Insert flyouts as regular toolbars, independent of the Standard and
Draw toolbars.

Displaying and Arranging Toolbars
In this section, I’ll use the Zoom toolbar to show you some ways you can control
and manipulate toolbars. Follow these steps:

1. Be sure the padlock icon in the lower-right corner of your screen is in
unlocked mode. Then, right-click any toolbar button on the screen to
open the Toolbars menu (see Figure 1.6).

T h e  To o l b a r s 1 5

�

LT has 24 toolbars
compared with
AutoCAD’s 35. The
additional toolbars in
AutoCAD are almost
all for 3D and ren-
dering tools.
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F I G U R E 1 . 6 :  The Toolbars menu

2. If you don’t see Zoom near the bottom of the list you should have a
down arrow there. Use it to scroll down, if necessary, and then click
Zoom to display the Zoom toolbar in the form of a floating box in the
drawing area.

Notice that the Zoom toolbar now has a title bar. Toolbars that are
positioned on the drawing area are called floating toolbars. They have
title bars; and, by placing the cursor on the title bar and holding
down the left mouse button, you can drag the toolbar around the
screen. Try this with the Zoom toolbar.

3. Click and drag the Zoom toolbar to the right side of the screen. You’ll
notice that as you drag it, the toolbar stays put, and you’re dragging a
rectangle of the same size as the toolbar (see Figure 1.7). As you drag
the rectangle to the right of the drawing area and begin to move it
off the drawing area onto the right side of the screen, the rectangle
becomes taller and thinner.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D1 6
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F I G U R E 1 . 7 :  Dragging the Zoom toolbar

4. Once the rectangle has changed shape, release the left mouse button.
The rectangle changes to the Zoom toolbar, which is now positioned
off the drawing area without its title bar.

This procedure is called docking a toolbar. Notice how the Standard and other
toolbars at the top of the drawing area have no title bars—they are docked.

T h e  To o l b a r s 1 7
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Continue with these steps:

1. Drag the Zoom toolbar back onto the drawing area, using the grab
bars at the top of the toolbar. You can easily change the shape of any
floating toolbar by dragging its edge. Let’s change the shape of this
toolbar.

2. Move the cursor to the far-right edge of the Zoom toolbar until the
crosshair cursor changes to a two-way arrow. 

Hold down the left mouse button with the cursor on the right edge of
the toolbar, and drag the arrow to the left until the rectangle changes
shape. Release the mouse button.

You can reshape and reposition each floating toolbar to fit on the
drawing area just as you like it. You won’t need the Zoom toolbar just
now, so you’ll remove it.

3. Move the cursor up to the title bar and click the box with an X in it to
close the Zoom toolbar.

Floating toolbars don’t affect the size of the drawing area, but they cover your
drawing. Each row or column of docked toolbars takes up space that would other-
wise be drawing area. You have to decide how many docked and floating toolbars
you need on the screen at a time. A good way to start is to leave the Standard, Lay-
ers, and Properties toolbars docked at the top of the screen and the Draw and Mod-
ify toolbars docked on the left side of the screen, as shown earlier in Figure 1.2.

If your toolbars are positioned as shown in Figure 1.8, continue with the next
section. If these toolbars are in another location on the drawing area or not
visible, try the steps you used in this section to dock them on the top and left
side of the drawing area. If the toolbars aren’t visible, right-click any visible
toolbar button, and choose the toolbar you need. Then, drag the toolbar to the
left side or top of the drawing area and dock it. Here are the positions I recom-
mend for the five toolbars that you should dock on your screen:

� At the top, just under the menu bar, dock the Standard toolbar.

� Below that, on the left side, dock the Layers toolbar, and to the right
of that, dock the Properties toolbar.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D1 8

�

Grab bars are the two
lines at the left end of
a horizontal toolbar
or at the top of a ver-
tical one. They repre-
sent the one place to
grab a docked toolbar
to move it.You can
also change a docked
toolbar into a floating
toolbar by double-
clicking its grab bars.
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� On the left side, dock the Draw toolbar.

� Next to the Draw toolbar, dock the Modify toolbar.

F I G U R E 1 . 8 :  The GUI with five toolbars docked on the top and left sides
of the drawing area

This arrangement of the toolbars will be convenient because you often use com-
mands on these five toolbars. When you need other toolbars temporarily, you can
use the Toolbars menu to display them in the drawing area and let them float. If
you have any other toolbars docked on the screen, use their grab bars to drag them
onto the screen. Then, click the Xs in their title bars to close them. Here is a par-
tial list of toolbars that you may have on your screen that need to be turned off:

� Display Order toolbar

� Styles toolbar

� Workspaces toolbar

Custom Toolbars
You can customize each toolbar, and you can build your own custom toolbars
with only the command buttons you use. You can even design your own buttons
for commands that aren’t already represented by buttons on the toolbars. These
activities are for more advanced users, however, and aren’t covered in this book.
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To find out more about how to customize toolbars, see Mastering AutoCAD 2007
and AutoCAD LT 2007 by George Omura (Wiley, 2006).

Workspaces
Now that you have your screen set up to look like Figure 1.8, you are ready to
proceed through the book. I’ll direct you to display additional toolbars as needed.
For now, though, save this setup as a new workspace. It’s a variation of the Auto-
CAD Classic or AutoCAD LT workspace that comes with the program.

1. Click Tools ➣ Workspaces ➣ Save Workspace As. This brings up the
Save Workspace dialog box (see Figure 1.9).

F I G U R E 1 . 9 :  The Save Workspace dialog box

2. Enter 2D Drawing and click Save. The computer works for a while,
and then returns you to your workspace. The new 2D Workspace
setup will remain as it now is until you change it or until you select a
different workspace.

3. Click Tools ➣ Workspaces; you’ll see the 2D Drawing workspace listed
on the Workspaces menu below 3D Modeling and AutoCAD Classic (see
Figure 1.10). In the Appendix, AutoCAD users will switch to the 3D
Modeling workspace and make a few adjustments to it.

F I G U R E 1 . 1 0 :  The Workspaces menu

4. For now, click 2D Drawing to close the menu and reset the screen to
your new workspace.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D2 0

�

For LT users, in 
Step 3, you will see
the 2D Drawing work-
space listed under
AutoCAD LT in the
Workspace menu.
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When you make changes to the new workspace—by adding a toolbar or chang-
ing the background color of the drawing area—you can easily update the 2D
Workspace to accommodate those changes. Follow steps 1 and 2 above, naming
the workspace again to 2D Workspace. You’ll get a warning window that tells you
that a workspace by that name already exists, and asks you if you want the new
arrangement to replace the old one. Click Yes.

The Keyboard
The keyboard is an important tool for entering data and commands. If you’re a good
typist, you can gain speed in working with AutoCAD by learning how to enter com-
mands from the keyboard. AutoCAD provides what are called alias keys—single
keys or key combinations that start any of several often-used commands. You can
add more or change the existing aliases as you get more familiar with the program.

In addition to the alias keys, you can use several of the F keys (function keys)
on the top row of the keyboard as two-way or three-way toggles (switches) to
turn AutoCAD functions on and off. Although buttons on the screen duplicate
these functions (Snap, Grid, and so on), it’s sometimes faster to use the F keys.

Finally, you can activate commands on the drop-down menus from the key-
board, rather than using the mouse. If you press the Alt key, an underlined letter,
called a hotkey, appears on each menu. Pressing the key for the underlined letter
activates the menu. Each command on the menu also has a hotkey. Once you
activate the menu with the hotkey combination, you can type the underlined let-
ter of these commands. For a few commands, this method can be the fastest way
to start them and to select options.

While working in AutoCAD, you’ll need to key in a lot of data, such as dimen-
sions and construction notes, answer questions with “yes” or “no,” and use the
arrow keys. You’ll use the keyboard constantly. It may help to get into the habit
of keeping your left hand on the keyboard and your right hand on the mouse if
you’re right-handed, or the other way around if you’re left-handed.

The Mouse
Your mouse most likely has two or three buttons. (If it’s an IntelliMouse, it has
two or more buttons with a wheel between them.) So far in this chapter, you
have used the left mouse button for choosing menus, commands, or command
options or for holding down the button and dragging a menu, toolbar, or win-
dow. The left mouse button is the one you’ll be using most often, but you’ll also
use the right mouse button.
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While drawing, you’ll use the right mouse button for the following three
operations:

� To display a menu containing options relevant to the particular step
you’re in at the moment

� To use in combination with the Shift or Control key to display a menu
containing special drawing aids called object snaps (see Chapter 10)

� To display a menu of toolbars when the pointer is on any icon of a
toolbar that is currently open

If you have a three-button mouse, the middle button is usually programmed to
display the Object Snap menu, instead of using the right button with the Shift
key. If you have an IntelliMouse, you can use the wheel in several ways to control
the view of your drawing. I’ll cover those methods in subsequent chapters.

AutoCAD makes extensive use of toolbars and the right-click menu feature. This
makes your mouse an important input tool. The keyboard is necessary for inputting
numeric data and text, and it has hotkeys and aliases that can speed up your work.
But the mouse is the primary tool for starting commands, selecting options, and
controlling toolbars.

The next chapter will familiarize you with a few basic commands that will
enable you to draw a small diagram. If you’re going to take a break and want to
close AutoCAD, choose File ➣ Exit, and choose not to save the drawing.

Are You Experienced?

Now you can…

0 open a new drawing using the Startup dialog box

0 recognize the elements of the AutoCAD Graphics window

0 understand how the Command window works and why it’s
important

0 use drop-down menus

0 call up and control the positioning of toolbars

0 save a workspace of your screen setup in AutoCAD
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